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 DOCUMENT STRUCTURE

Introduction to FrameMaker books
A book file is a FrameMaker file that ties multiple files together so you can work with them as 
one unit. This grouping allows you to generate a single table of contents or index for the 
documents, and it simplifies printing, page numbering, cross-referencing, and formatting. 

It is also useful to know what a book is not. When you add files to a book file, you are not 
making a copy of the file; you are simply creating a pointer to the existing file. You can open the 
file by double-clicking it in the book file list, although this is identical to opening the file directly 
without going through the book file.

Book files do not update dynamically; you must update the book to update pagination, cross-
references, and generated files. This process is described in detail in Chapter 2.

Project directory structure
Create a folder to store all documents in the book, preferably named something similar to the 
project name. Create a subfolder called “images” to store all images in the book. If you move the 
book files and images to another server or directory, keep the directory structure in tact to 
prevent broken links.
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Document Structure
The multichapter FrameMaker book is made up of the following segments:

� Front matter - contains a cover page and copyright page
� Table of contents
� Chapter - your document may consist of multiple FrameMaker chapter files
� Appendix
� Glossary
� Index

The book is configured to print double-sided. 

Templates

Standard templates are available for each section of the book and are located at the following 
network address:

\\public\information technology\documentation\templates\framemaker\
multichapter book\

� frontmatter.fm
� TOC.fm (capitalized purposely for FrameMaker recognition)
� chapter.fm
� appendix.fm
� glossary.fm
� IX.fm (capitalized purposely for FrameMaker recognition)

For consistency, each template file contains the same paragraph and character tags, table 
formats, and reference pages. 

� Copy these template files to your working project folder and remove the read-only 
attribute in each file’s properties.

Front matter
The frontmatter.fm template consists of two pages:

1. A cover page containing the company logo and title of the book. Include the version 
number if applicable.

2. Page two is the standard copyright page. Update the copyright year (yyyy), but do not 
change the copyright text.
1 - 2 December 2002 
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Front matter paragraph tags

The structure of the frontmatter.fm document is as follows:

� The placeholder for the title of the book is centered vertically and horizontally.
� The book title uses the Title cover paragraph tag.
� Page one (cover page) does not contain headers or footers.
� On page two, the copyright information is in a text box to control the location of the 

text. 
� The copyright text uses the Body tag. 
� Insert the year of the publish date in the first line of the copyright information.
� The header on page two only contains the book title variable. Refer to the “Headers” 

section on page 1-4 for instructions on changing the book title.
� The footer on page two contains the publication month/year and the page number. 

Page numbers in frontmatter.fm are lower case roman numerals (ii,iii). Refer to the 
“Footers” section on page 1-4 for instructions on changing the month/year variable.

Chapters
Chapters use the chapter.fm template. The chapter number and chapter title placeholders are 
filled in for you. You simply type your own chapter title and leave the chapter number as is.

Chapter paragraph tags

The structure of the chapter document is as follows:

� The chapter number in the top right uses the ChapterNumber paragraph tag. The 
number that displays may continue to be “1” until you set the document numbering 
parameters at the chapter level (page 1-10) and book level (page 2-3).

� The title of the chapter uses the ChapterTitle paragraph tag. Attached to this tag is the 
standard blue line which is stored on the document’s reference page.

� After typing the chapter title, press ENTER to advance to the body of the document 
where you can type the first Heading 1. 

� The text sections of the chapter use paragraph tags such as Heading 1, Heading 2, 
Heading 3, and Body for standard text.

� Use the Body Indent paragraph tag if you need a paragraph under a bulleted list or 
numbered steps.

� The items in this bulleted list use the Bulleted paragraph tag. If you need to list several 
items under a bullet, use the BulletIndentSquare paragraph tag:
� This is the BulletIndentSquare tag.

� Use the BulletIndentRound paragraph tag if you need a bulleted list under Body Indent 
or numbered steps:
� This is the BullentIndentRound tag that is used under numbered steps.
XYZ Corporation  1 - 3



Chapters
FrameMaker Template User Guide Headers
� If an instruction only has one step, use the OneStep paragraph tag:
� This is an example of the OneStep paragraph tag.

Headers

Each document in the book has a header area that contains the book title, chapter title, and the 
current Heading 1 and Heading 2. The book title is the only variable you change manually. Do 
not alter other items in the header. The book title must match the title of the book on the cover 
page in frontmatter.fm.

Add the book title

1. From the View menu, select Master Pages.
2. From the left or right page, double-click the book title variable.

The Variable window opens.
3. Click Edit Definition.
4. Type the name of your book as it appears on the cover page in frontmatter.fm.
5. Click Done.
6. Click Replace.

The book title changes on all master pages for this document.
7. From the View menu, select Body Pages.
8. Repeat these instructions for every document that makes up your book.

Footers

Each document in the book has a footer area that contains the page number, the publication 
month/year, and the name XYZ Corporation. The publication month/year is the only variable 
you change manually. Do not alter other items in the footer. The structure is as follows:

� The page number is in “chapter number-page number” format (3-18) and is linked to 
the page number setting on the reference page.

� The publication month/year and the name XYZ Corporation alternate pages. The right 
master page contains XYZ Corporation on the right and the page number on the left. 
The left master page contains the page number on the right and the publication month/
year on the left. 

Add the publication month year

1. From the View menu, select Master Pages.
2. From the left or right page, double-click on the Month Year variable.

The Variable window opens.
3. Click Edit Definition.
4. Type the month and year. For example, June 2002.
5. Click Done.
1 - 4 December 2002 
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6. Click Replace.
The date changes on all master pages for this document.

7. From the View menu, select Body Pages.
8. Repeat these instructions for every document that makes up your book.

Insert a note, tip, or caution

Notes, tips, and cautions are placed in a document by inserting a specific table format. The table 
format you select depends on whether the table is located under standard body text or indented 
text. Indented text in a chapter or appendix is defined as any paragraph tag indented from the 
Body paragraph tag. 

To insert a note, tip, or caution under standard body text

1. Place your cursor at the end of the last line of text using the Body tag.
2. From the Table menu, select Insert Table.
3. Select Note, Caution, or Tip.

A two-cell table appears with the note, tip, or caution icon in the left cell.
4. Type the text in the cell on the right.

Below is an example of a note under text that uses the Body paragraph tag.

To insert a note, tip, or caution under indented text

Examples of indented text are paragraph tags such as Numbered, BodyIndent, and Bulleted. Use 
the following instructions to insert a note, tip, or caution under indented text.

1. Place your cursor at the end of the last line of text that uses a Numbered, BodyIndent, 
or Bulleted tag.

2. From the Table menu, select Insert Table.
3. Select NoteIndent, CautionIndent, or TipIndent.

A two-cell table appears with the note, tip, or caution icon in the left cell.
4. Type the text in the cell on the right. 

This is an example:

Standard table formats

There are three table formats in addition to the six tables for inserting notes, tips, and cautions: 

� Shaded Heading

This note text aligns with the left margin of the text above.

See how the text in the right cell of this indented tip aligns with the text in Step 4.
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� Side Heading
� 2 col no border

You may add rows and columns, or additional formatting to suit your needs. Refer to the 
following examples.

Table 3: 2 col no border (simulated) 

Table 1: Shaded Heading

Table 2: Side Heading
1 - 6 December 2002 
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Import graphics by reference

Many documents have graphics such as screen shots, logos, and icons. The Images subfolder 
stores the graphic files used throughout your book. Always import these graphics into the 
chapter by reference, which means you are linking the image to the graphic file in the Images 
folder. The result is a smaller document file size and more control over resizing and resolution. 

Use the following instructions to import a graphic by reference.

1. Place your cursor at the end of the last line of text that is just before the area where you 
want to import the graphic.

2. From the File menu, select Import, and then select File.
The Import window opens.

3. Navigate to the \Images folder and click once on the graphic file you want to import.
4. Select the Import by Reference option.
5. Click Import.

The Import Graphic Scaling window opens.
6. Type a custom dpi setting.

7. Click Set.
The graphic imports into a centered anchored frame.

8. From the Special menu, select Anchored Frame.
The Anchored Frame window opens.

9. Change the Alignment field to Left and click Edit Frame.
The anchored frame moves to the left margin.

10. Click once on the graphic to select it. 

Do not resize a graphic using the handles after you import it into the document. The 
import process allows you to adjust the size, or dpi of the graphic without losing clarity. If 
you need to resize the graphic after the import, follow the instructions on page 1-8.

You can determine how large or small the graphic appears in the document with a 
scaling factor. In FrameMaker, scaling is set by dpi (the standard windows setting 
is 96 dpi). The highest recommended dpi is 125, however, wider graphics may 
need as much as 175 to fit within the margins. 

To adjust the width of the anchored frame, click the border of the anchored frame 
and adjust the width by dragging the handles to the appropriate size.
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11. Drag the graphic so the left edge aligns with the text of the previous step, bullet, or 
paragraph text. Refer to the following example of a graphic positioned underneath 
numbered steps.

Example:

Perform a search for a file using the advanced options.

1. From the Tools menu, select Find, and then select Files or Folders.
2. Click the Advanced tab..

Changing the graphic size (dpi) after the import

You can change the size of a graphic after it is imported into the document by adjusting the dpi 
setting. This is useful if the graphic is initially imported at the wrong size.

1. Click once on the graphic you want to resize.
2. From the Graphics menu, select Object Properties.

The Object Properties window opens.
3. In the center of the window, click Set dpi.
4. Type a new custom dpi setting. 

5. Click Set.

Missing graphics

If a FrameMaker document indicates missing graphics, it is likely the graphic was deleted or 
moved from the Images folder. Locate the graphic file, or create a replacement with the same file 
name, and place a copy in the Images subfolder under the working project folder.

The higher the dpi setting, the smaller the graphic. Do not type a dpi setting lower 
than 96.

The graphic 
is aligned
with the left
 

 

 

text margin.
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Create index markers

Index entries are created by placing index markers in each chapter before generating the index 
document. Index entries are sorted alphabetically in the final version of a generated index. 
Entries with the same text are merged into a single entry with multiple page references. You can 
add building blocks to control the form of the index entry such as specifying a subentry or a 
cross-reference to another entry. 

The following section provides a quick overview on adding index markers. For detailed 
instructions, see page 332 in the FrameMaker 6.0 User Guide. 

Add index markers

Use the following instructions to add index markers to a chapter or appendix. Index markers are 
shown when text symbols are visible. If you add a marker in error, select the word or phrase 
following the marker, press DELETE, and then type the text again. 

1. Select the text you want to include as an index entry.
2. From the Special menu, select Marker.
3. Select Index from the Marker Type drop-down list.
4. Change the text in the window to all lower case (except proper nouns).
5. Click New Marker.

A marker symbol ( T ) appears if text symbols are visible.

Place several entries in one marker

To place several index entries in one marker, use a semicolon (:) between entries, as in the 
following example:

Create subentries in index entries

You can group several entries under one entry for a larger category of information by marking 
the entries as subentries. To do this, separate the main entry from the subentry with a colon (:). 

For example, to create the first subentry under “printers,” type printers:cancel print
jobs. Continue with other items under the entry in the same manner. The second subentry in the 
list is typed as printers:controlling print jobs. The third subentry is typed as 
printers:printing double-sided. 

The end result looks like the following:

Marker Text Results in Index Entry

folders;shortcuts to folders;create a new folder folders 1-24
shortcuts to folders 1-24
create a new folder 1-24
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Steps for finishing the chapter

When you are finished with a chapter, use this checklist to complete the formatting:

� From the Edit menu, select Spelling Checker. 
� Make sure no headings start near the bottom of the page. If so, force the heading to 

start at the top of the next page. Insert the cursor in the heading and click Special, and 
then click Page Break. Select the option for At Top of Next Available Page and click 
OK.

� Add index entries. See the “Create index markers” section on page 1-9 for instructions.
� Check the last few pages of the chapter to make sure there are no unused pages. Delete 

the unused pages by clicking Special, and then click Delete Pages. Be sure to enter the 
correct page numbers to delete as this action cannot be reversed.

� Set the document numbering for chapter and page number. Refer to the next section 
for instructions.

Document numbering

Document numbering is an important part of a multichapter book, as it correctly numbers each 
chapter and page number, and determines how the chapter is listed on the table of contents. 
Follow these instructions after you are finished with the chapter.

1. Open the chapter document.
2. From the Format menu, select Document, and then Numbering.

The Numbering Properties window opens.
3. On the Chapter tab, do one of the following:

� Select the Chapter option and type 1 if this document is the first chapter. 
� Select the Continue Numbering from Previous File in Book option if this is chapter 

2 or higher.
4. Verify the Format field is Numeric (14). 
5. Click OK.

Marker Text Results in Index Entry

printers:cancel print jobs
printers:controlling print jobs
printers:printing double-sided

printers
cancel print jobs 1-2
controlling print jobs 1-18
printing double-sided 1-20
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Appendix
An appendix uses the appendix.fm template and is primarily used for reference material. The 
appendix number and appendix title placeholders are filled in for you. You simply type your 
own appendix title and leave the appendix number (letter) as is. Every appendix uses an 
uppercase alphanumeric numbering sequence (A-Z).

Appendix paragraph tags

The structure of the appendix document is as follows:

� The appendix letter is in the same position as the chapter number in standard chapter 
documents, and uses the same ChapterNumber paragraph tag. However, the document 
number format is changed to an reflect uppercase alphabetic numbering sequence. The 
letter that displays may continue to be “A” until you set the document numbering 
parameters at the document (page 1-10) and book level (page 2-3). 

� The title of the appendix uses the AppendixTitle paragraph tag. Attached to this tag is 
the standard blue line which is stored on the document’s reference page.

� After typing the appendix title, press ENTER to advance to the body of the document 
where you can type the first Heading 1. 

� The text sections in the appendix use the same paragraph tags as the chapter document.
� Refer to the Headers section on page 1-4 for changing the book title in the header area.
� Refer to the Footers section on page 1-4 for changing the publication month/year.

Steps for finishing the appendix

When you are finished with an appendix, use this checklist to complete the formatting:

� From the Edit menu, select Spelling Checker.
� Make sure no headings start near the bottom of the page. If so, force the heading to 

start at the top of the next page. Insert the cursor in the heading and click Special, and 
then click Page Break. Select the option for At Top of Next Available Page and click 
OK.

� Add index entries. See “Create index markers” on page 1-9 for instructions.
� If your book is set for two-sided printing, make sure the appendix ends on an even 

numbered page.
� Check the last few pages of the appendix to make sure there are no unused pages. 

Delete the unused pages by clicking Special, and then click Delete Pages. Be sure to 
enter the correct page numbers to delete as this action cannot be reversed.

� Set the document numbering for the appendix letter and page numbers. Refer to the 
next section, “Appendix numbering” for instructions.
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Appendix numbering

Document numbering is an important part of a multichapter book, as it correctly labels each 
appendix and page number, and determines how the appendix is listed on the table of contents. 
Follow these instructions after you are finished with the appendix.

1. Open the appendix document.
2. From the Format menu, select Document, and then Numbering.

The Numbering Properties window opens.
3. On the Chapter tab, do one of the following:

� Select the Chapter option and type 1 if this document is the first appendix. 
� Select the Continue Numbering from Previous File in Book option if this is 

appendix B or higher.
4. Verify the Format field is ALPHABETIC (N). 
5. Click OK.

Glossary
To use the glossary template, copy the glossary.fm file into the working project folder. Remove 
the read-only properties from the file using Windows Explorer. 

Glossary paragraph tags

The structure of the glossary is as follows:

� The title of the glossary uses the GlossaryTitle paragraph tag. Attached to this tag is 
the standard blue line which is stored on the document’s reference page. This title is 
already in place and requires no attention.

� The alphabetic letters that separate groups of terms use the GlossaryLetter paragraph 
tag. 

� The term you are defining uses the GlossaryTerm paragraph tag. The tag is designed to 
advance you to the GlossaryDefinition tag when you press ENTER.

� The definition uses the GlossaryDefinition tag. The tag is designed to return you to the 
GlossaryTerm tag when you press ENTER.

� Refer to the Headers section on page 1-4 for changing the book title in the header area.
� Refer to the Footers section on page 1-4 for changing the publication month/year.
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 CREATING A FRAMEMAKER BOOK

Create a book file
Creating a book file automates several book maintenance tasks. When you update the book, the 
following things happen:

� FrameMaker updates cross-references in every file in the book.
� FrameMaker updates the book’s pagination.
� FrameMaker regenerates generated files, such as the table of contents and the index.
� FrameMaker scans every file in the book and updates the items in the generated files 

and their page numbers.

Book files do not update dynamically; you must update the book to update pagination, cross-
references, and generated files.

Use the following instructions to create a book file.

1. From FrameMaker, open one of the files you want to include in the book.
2. From the File menu, select New, and then select Book. 

An alert message appears asking if you want to include the document in the book.
3. Click Yes.

A new window appears showing the contents of the book. See the following example.

4. From the File menu, select Save Book As. 
5. Type a file name for the book and click Save.

A “.book” extension is added to the file name.
XYZ Corporation 2 - 1
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Add document files to the book

You can add two types of files to a book: documents and generated files. When adding a 
document file to a book, FrameMaker adds the file’s name and location to the book, and a link is 
established between the file and book. Use the following instructions to add document files to a 
book.

1. From the book window, select Add, and then select Files.
2. Select the document file you want to add to the book and click Add.
3. Repeat Step 2 until all files are added.
4. From the book window, select File, and then select Save Book.

Generate the index
Once you have generated the index entries in the chapter and appendix documents, it is time to 
generate a standard index. Use the following instructions to generate an index for your book.

1. From Windows Explorer, navigate to your working project directory.
2. Rename IX.fm to nameofbookIX.fm, where nameofbook is the exact name of your 

book file. For example, if your book file is named “premir.book,” rename the index 
file to “premirIX.fm.” Be sure to type “IX” in upper case. There are no spaces between 
nameofbook and IX.

3. Open your book file in FrameMaker. 
4. Select Add, and then select Standard Index.

The Set up Standard Index window opens.
5. Verify the only marker in the left column is “Index.”
6. Click Add.

The index file generates based on the index template. 
7. Drag the index file to the bottom of the list of documents in the book.
8. From the book window, double-click the index file and verify the contents. 
9. Change the book title variable in the header and the publication month/year variable in 

the footer. Refer to page 1-4 for instructions.

You can rearrange the order of the document files in a book by clicking and 
dragging a document name to the desired position. Refer to page 365 in the 
FrameMaker 6.0 User Guide for more information on rearranging, deleting, and 
renaming files in a book.

Make sure you have a copy of the IX.fm template in your working project directory 
before performing these instructions. In addition, remember to remove the read-only 
attribute in the file’s properties.
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Set the book-level document numbering
The numbering for chapters and appendices must be set at both the document level (page 1-10) 
and the book level. Use the following instructions to set the document numbering at the book 
level. 

1. Open the book file in FrameMaker. 
The book window opens.

2. Click once on the first chapter and select Format, Document, and then Numbering.
The Numbering Properties window opens.

3. On the Chapter tab, select the Chapter option and type 1. 
4. Verify the Format field is Numeric (14). 
5. Click OK.
6. Save and close the document.
7. Click once on the second chapter and select Format, Document, and then 

Numbering.
The Numbering Properties window opens.

8. On the Chapter tab, select the Continue Numbering from Previous File in Book 
option. 

9. Verify the Format field is Numeric (14). 
10. Click OK.
11. Save and close the document.
12. Click once on the third chapter and repeat Steps 7 – 11 for the remaining chapters.

You must follow these instructions in the order shown. Problems with chapter numbering 
may arise if the steps are performed out of order. Also, all individual documents within the 
book must be closed before you begin.
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13. When all chapters are numbered in order, click once on the first appendix document 
and select Format, Document, and then Numbering. 
The Numbering Properties window opens.

14. On the Chapter tab, select the Chapter option and type 1. 
15. Verify the Format field is ALPHABETIC (N). 
16. Click OK.
17. Save and close the document.
18. Click once on the second appendix and select Format, Document, and then 

Numbering. If there are no more appendices, go to Step 24.
The Numbering Properties window opens.

19. On the Chapter tab, select the Continue Numbering from Previous File in Book 
option. 

20. Verify the Format field is ALPHABETIC (N). 
21. Click OK.
22. Save and close the document.
23. Click once on the third appendix and repeat Steps 18 – 22 for the remaining 

appendices.
24. When all chapters and appendices are numbered in order, select File, and then select 

Save Book.

Generate a table of contents
Use the following instructions to generate a table of contents for your book.

1. From Windows Explorer, navigate to your working project directory.
2. Rename TOC.fm to nameofbookTOC.fm, where nameofbook is the exact name of 

your book file. For example, if your book file is named “premir.book,” rename the 
table of contents file to “premirTOC.fm.” Be sure to type “TOC” in upper case. There 
are no spaces between nameofbook and TOC.

3. Open your book file in FrameMaker, and select Add, and then Table of Contents.
The Set up Table of Contents window opens.

If there are no appendices, go to Step 24.

Make sure you have a copy of the TOC.fm template in your working project directory before 
performing these instructions. In addition, remember to remove the read-only attribute in the 
file’s properties.
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4. In the Don’t Include panel, select the following paragraph tags one by one and click 
the arrow pointing to the left. This moves the tag to the left portion of the window.
� AppendixTitle
� ChapterNumber
� ChapterTitle
� Heading 1
� Heading 2
� Heading 3
� GlossaryTitle
� IndexTitle

5. Click Add.
The table of contents document generates based on the TOC template. The file is 
placed in the book window.

6. Drag the table of contents file under frontmatter.fm in the book window.
7. From the book window, double-click the TOC file and verify the contents. 
8. Change the book title variable in the header and the publication month/year variable in 

the footer. Refer to page 1-4 for instructions.
9. Save the TOC document.

Updating the book
After setting up a book and specifying numbering properties for each file in the book, you 
update the book as a single unit. This is the last step in book building. Even though you generate 
and update in one step, the two processes are different:

Generating creates the table of contents and indexes in the book file. Updating corrects the 
numbering in all files in the book and revises cross-references so they are correct based on the 
new numbering. Empty pages are added where required.
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Be sure to generate and update a book whenever you make any of the following changes to a 
document or a book file:

� Editing that affects pagination
� Editing that affects the wording of a generated file such as changes to a chapter title
� Adding a new color (so color separations will be accurate)
� Adding new index entries
� Changing conditional text settings or indicators
� Changing the numbering of documents or generated files
� Changing formatting information in the special text flow on a reference page of a 

generated file 
� Rearranging, adding, or removing files in a book

To update the files in a book

1. From the book window, select Edit, and then select Update Book.
2. Move the names of the files you want to generate to the Generate scroll list. 

3. Click Update. 

4. Save any open individual documents. Open files are updated only in memory and not 
on the disk. 

5. From the book window, select File, and then select Save Book.

Only generated files appear in the list. If no files are present, the book has no 
generated files. If no files appear in the lists—or if you move all the files to the 
Don’t Generate list—you should still continue to the next step to update the 
book’s pagination, numbering, and cross-references.

For information on messages you may see in the Book Error Log, see the 
Troubleshooting section on page 374 in the FrameMaker 6.0 User Guide.
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Create a PDF File
FrameMaker allows you to convert a single document or an entire book to a Portable Document 
Format (PDF) file. This format makes it easy to distribute and prevents users from making 
changes to the content. 

Print as postscript file and distill to PDF

1. If the book is already open, save and close any individual documents.
2. Open the book file and select File, and then select Print Book.

The Print Book window opens.
3. Select the Print Only to File option.
4. Type a path and file name. Use the working project folder for the path, and make sure 

the file extension is “.ps” for postscript. 
5. Click Setup beside the printer name and select Acrobat Distiller from the list.
6. Click OK.
7. Select the Generate Acrobat Data option.
8. Click PDF Setup. 
9. Use the following screen as a reference when including paragraph tags. Include 

paragraphs tags for AppendixTitle, ChapterTitle, ContentsTitle, GlossaryTitle, 
Headings 1 – 3, and IndexTitle.

10. Click Set. 
The Print dialog box returns. 
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11. Click OK.
12. Click Print.

The postscript file is generated and placed in the working project folder.
13. From Windows Explorer, navigate to the working project folder.
14. Double-click on the .ps file you just created.

Acrobat Distiller opens and converts the file to PDF.

15. Open the new PDF file and verify it converted correctly. Check the bookmarks in the 
PDF table of contents.

Troubleshooting PDF Problems

These instructions provide a possible solution if you experience error messages in Distiller when 
creating a PDF file such as “Error: undefined,” or “Offending Command.” For example:

1. Open Acrobat Distiller.
2. From the Settings menu, select Job Options.

The Print - Job Options window opens.
3. Click the Compression tab.

If you receive errors while Distiller is converting the book, refer to the next 
section on “Troubleshooting PDF Problems.” 
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4. Make the settings on your window match the following example.

5. Click OK.
6. Recreate the PDF file using the instructions in the “Create a PDF File” section on page 

2-7.
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Paragraph tag usage
The following tables lists all the paragraph tags used in our documentation and their associated 
application.

Paragraph Tag Application

AppendixTitle Subject name of an appendix chapter.

AppendixTitleTOC Used on the table of contents to print the subject name of the appendix 
chapter(s).

Body Used for general paragraph text.

Body Indent Text that is indented from the Body tag.

Bulleted First level bullet, indented 1.25, round shaped.

BulletIndentRound Second level bullet, indented 1.43, round shaped.

BulletIndentSquare Second level bullet, indented 1.43, square shaped.

CellBody Text in a table cell.

CellHeading Heading text in a table.

ChapterNumber Numbers the chapters starting at 1.

ChapterTitle Subject name of a chapter.

ChapterTitleTOC Used on the table of contents to print the name of the chapter to the 
right of the chapter number.

ContentsTitle Used at the top of the first page of the table of contents to place a title 
on the page.

Footer Used on the master page in the footer area for the date and title of the 
book.

GlossaryBullet For bulleted lists in the glossary.

GlossaryDefinition Definition of a term in the glossary.
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GlossaryLetter Letters of the alphabet used to group related sections of terms in the 
glossary.

GlossaryTerm The term you are defining in the glossary.

GlossaryTitle Used at the top of the first page of the glossary to place a title on the 
page. 

GlossaryTitleTOC Used on the table of contents to print the word “Glossary.”

GroupTitlesIX Letters of the alphabet used to group related sections of index entries.

Header Used on the master pages in the header area for the book title, chapter 
names, and section names.

Heading 1 First level heading in chapters and appendices.

Heading 1TOC Used on the table of contents to import the names of Heading 1s from 
chapters and appendices.

Heading 2 Second level heading in chapters and appendices.

Heading 2TOC Used on the table of contents to import the names of Heading 2s from 
chapters and appendices.

Heading 3 Third level heading in chapters and appendices.

Heading 3TOC Used on the table of contents to import the names of Heading 3s from 
chapters and appendices.

Heading 4 Fourth level heading in chapters, prefaces, and appendices.

Heading 5 Fifth level heading in chapters and appendices.

HeadingRunIn Not used, however, it can be used for any heading or term that runs into 
a paragraph.

IndexIX System generated for the index. Do not use.

IndexTitle Used at the top of the first page of the index to place a title on the page.

IndexTitleTOC Used on the table of contents to print the word “Index.” 

InsertCaution Do not use this paragraph tag and do not delete it. To insert a caution, 
select Table, Insert Table, and select either Caution or CautionIndent 
from the list. 

InsertNote Do not use this paragraph tag and do not delete it. To insert a note, 
select Table, Insert Table, and select either Note or NoteIndent from 
the list.

InsertTip Do not use this paragraph tag and do not delete it. To insert a tip, select 
Table, Insert Table, and select either Tip or TipIndent from the list.

Paragraph Tag Application
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Level1IX Level 1 index entry; system generated.

Level2IX Level 2 index entry; system generated.

Level3IX Level 3 index entry; system generated.

Numbered First level numbering when entering numbered steps; starts at 2.

Numbered1 First level numbering when entering numbered steps; starts at 1.

OneStep Use when your instructions only have one step. 

SeparatorsIX System generated for the index. Do not use.

TableFootnote Footnote for a table if necessary.

TableTitle Used for the title bar above a table.

Title You can use this tag for a subtitle on the cover page of the front matter 
template.

Title cover The title of the book on the frontmatter.fm document.

Paragraph Tag Application
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Basic tab

Paragraph Indent
First Left Right Above Below LS Align Next Tabs

AppendixTitle 0 0 1 26 12 26F L Heading 1

AppendixTitleTOC 0 0 0 14 6 14F L 6.539 L

Body 1 1 0.125 7 7 13F L

Body Indent 1.43 1.43 0.15 7 7 13F L Body

Bulleted 1.25 1.43 0.3 3 3 13F L Bulleted 1.43 L

BulletIndentRound 1.43 1.63 0.3 3 3 13F L BulletIndentRound 1.63 L

BulletIndentSquare 1.43 1.63 0.3 3 3 13F L BulletIndentSquare 1.63 L

CellBody 0 0 0 3 3 13F L

CellHeading 0 0 0 0 0 13 L

ChapterNumber 0 0 0.5 0 35 50F R ChapterTitle

ChapterTitle 0 0 1.0 26 12 26F L Heading 1

ChapterTitleTOC 0 0 0 14 6 14F L 6.539 L

ContentsTitle 0 0 1.0 26 12 26 L

Footer 0 0 0 20 0 10 L 0.681 L
3.0 C
6.927 R

Footnote 0.25 0.417 0.25 0 0 12 L 0.417 L

GlossaryBullet 0.187 0.378 0.3 3 3 13 L GlossaryBullet 0.378 L
1.43 L

GlossaryDefinition 0 0 0.125 0 7 13F L GlossaryTerm

GlossaryLetter 0 0 0 15 0 22F L GlossaryTerm

GlossaryTerm 0 0 0 16 0 14 L GlossaryDefinition

GlossaryTitle 0 0 1 26 12 26F L GlossaryLetter

GlossaryTitleTOC 0 0 0 14 6 14F L

GroupTitlesIX 0 0 0 15 0 22F L
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Header 0 0 0 0 0 10 L 0.681 L
3.0 C
6.875 R

Heading 1 0 0 0.15 38 10 19 L Body

Heading 1TOC 1.0 0 0 3.0 1.0 13F L 6.57 L

Heading 2 0 0 0 25 12 12F L Body

Heading 2TOC 1.25 0 0 0 0 13F L 6.57 L

Heading 3 1.0 1.0 0.5 18 7 13F L Body

Heading 3TOC 1.5 0 0 0 0 13F L 6.57 L

Heading 4 1.0 1.0 0.5 23 0 13F L Body

Heading 5 1.0 1.0 0.5 20 0 12F L Body

HeadingRunIn 0 0 0 6 0 14 L Body

IndexIX 0 0 0 0 0 14F L 3.125 L

IndexTitle 0 0 1.0 26 12 26F L

IndexTitleTOC 0 0 0 14 6 14F L

InsertCaution 0 0 0 0 0 0F L

InsertNote 0 0 0 0 0 0F L

InsertTip 0 0 0 0 0 0F L

Level1IX 0 0 0 0 0 13F L

Level2IX 0.125 0.125 0 0 0 13F L

Level3IX 0.25 0.25 0 0 0 13F L

Numbered 1.0 1.43 0.3 3 3 13F L Numbered 1.361 R
1.43 L

Numbered1 1.0 1.43 0.3 5 3 13 F L Numbered 1.361 R
1.43 L

OneStep 1.25 1.43 0.5 3 5 13 L Body 1.43 L

SeparatorsIX 0 0 0 0 0 14F J

TableFootnote 0.25 0.417 0.25 0 0 12 L 0.417 L

TableTitle 1.0 0 0 0 0 12 L

Paragraph Indent
First Left Right Above Below LS Align Next Tabs
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Title 0 0 0 24 12 24 C Body

Title cover 0 0 0 11 0 22 L 0.35 L
0.54 L
0.78 L
1.06 L

Paragraph Indent
First Left Right Above Below LS Align Next Tabs
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Default Font tab

Paragraph Fam Size Ang Wt Var Color Sprd Strch Pain 
Kern Other

AppendixTitle Arial 22 Reg Bold Reg Black 0 100 Y Small Caps

AppendixTitleTOC Arial 12 Reg Bold Reg Black 0 100 Y

Body TNR 11 Reg Reg Reg Black 0 100 Y

Body Indent TNR 11 Reg Reg Reg Black 0 100 Y

Bulleted TNR 11 Reg Reg Reg Black 0 100 Y

BulletIndentRound TNR 11 Reg Reg Reg Black 0 100 Y

BulletIndentSquare TNR 11 Reg Reg Reg Black 0 100 Y

CellBody TNR 11 Reg Reg Reg Black 0 100 Y

CellHeading TNR 11 Reg Bold Reg Black 0 100 Y

ChapterNumber Arial 72 Reg Bold Reg Black 0 100 Y

ChapterTitle Arial 22 Reg Bold Reg Black 0 100 Y Small Caps

ChapterTitleTOC Arial 12 Reg Bold Reg Black 0 100 Y

ContentsTitle Arial 22 Reg Bold Reg Black 0 100 Y Small Caps

Footer Arial 8 Reg Reg Reg Black 0 100 Y

Footnote TNR 10 Reg Reg Reg Black 0 100 Y

GlossaryBullet TNR 11 Reg Reg Reg Black 0 100 Y

GlossaryDefinition TNR 11 Reg Reg Reg Black 0 100 Y

GlossaryLetter Arial 14 Reg Bold Reg Black 0 100 Y

GlossaryTerm Arial 12 Reg Bold Reg Black 0 100 Y

GlossaryTitle Arial 22 Reg Bold Reg Black 0 100 Y Small Caps

GlossaryTitleTOC Arial 12 Reg Bold Reg Black 0 100 Y

GroupTitlesIX Arial 14 Reg Bold Reg Black 0 100 Y

Header Arial 8 Reg Bold Reg Black 0 100 Y

Heading 1 Arial 16 Reg Bold Reg Black 0 100 Y

Heading 1TOC TNR 11 Reg Reg Reg Black 0 100 Y

Heading 2 Arial 12 Reg Bold Reg Black 5% 100 Y

Heading 2TOC TNR 11 Reg Reg Reg Black 0 100 Y
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Heading 3 Arial 11 Reg Bold Reg Black 8% 100 Y

Heading 3TOC TNR 11 Reg Reg Reg Black 0 100 Y

Heading 4 Arial 11 Ital Bold Reg Black 15% 100 Y

Heading 5 Arial 10 Reg Reg Reg Black 15% 100 Y

HeadingRunIn TNR 11 Reg Bold Reg Black 0 100 Y

IndexIX TNR 12 Reg Reg Reg Black 0 100 Y

IndexTitle Arial 22 Reg Bold Reg Black 0 100 Y Small Caps

IndexTitleTOC Arial 12 Reg Bold Reg Black 0 100 Y

InsertCaution TNR 5 Reg Reg Reg Black 0 100 Y

InsertNote TNR 5 Reg Reg Reg Black 0 100 Y

InsertTip TNR 5 Reg Reg Reg Black 0 100 Y

Level1IX TNR 11 Reg Reg Reg Black 0 100 Y

Level2IX TNR 11 Reg Reg Reg Black 0 100 Y

Level3IX TNR 11 Reg Reg Reg Black 0 100 Y

Numbered TNR 11 Reg Reg Reg Black 0 100 Y

Numbered1 TNR 11 Reg Reg Reg Black 0 100 Y

OneStep TNR 11 Reg Reg Reg Black 0 100 Y

SeparatorsIX TNR 11 Reg Reg Reg Black 0 100 Y

TableFootnote TNR 10 Reg Reg Reg Black 0 100 Y

TableTitle Arial 10 Reg Bold Reg Black 0 100 Y

Title TNR 18 Reg Bold Reg Black 0 100 Y

Title cover Arial 22 Reg Bold Reg Black 0 100 Y

Paragraph Fam Size Ang Wt Var Color Sprd Strch Pain 
Kern Other
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Pagination tab

Paragraph Start Keep With Widow/
Orphan Format

AppendixTitle Anywhere 2 In Column

AppendixTitleTOC Anywhere 1 In Column

Body Anywhere 3 In Column

Body Indent Anywhere 3 In Column

Bulleted Anywhere 3 In Column

BulletIndentRound Anywhere 3 In Column

BulletIndentSquare Anywhere 3 In Column

CellBody Anywhere 3 In Column

CellHeading Anywhere Next 2 In Column

ChapterNumber Anywhere Next 3 In Column

ChapterTitle Anywhere 2 In Column

ChapterTitleTOC Anywhere 1 In Column

ContentsTitle Anywhere 1 In Column

Footer Anywhere 2 Across All Columns

Footnote Anywhere 2 In Column

GlossaryBullet Anywhere 2 In Column

GlossaryDefinition Anywhere 2 In Column

GlossaryLetter Anywhere Next 1 In Column

GlossaryTerm Anywhere Next 2 In Column

GlossaryTitle Anywhere 2 In Column

GlossaryTitleTOC Anywhere 1 In Column

GroupTitlesIX Anywhere Next 1 In Column

Header Anywhere 2 Across All Columns

Heading 1 Anywhere Next 2 In Column

Heading 1TOC Anywhere 1 In Column

Heading 2 Anywhere Next 2 In Column

Heading 2TOC Anywhere 1 In Column
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Heading 3 Anywhere Next 2 In Column

Heading 3TOC Anywhere 1 In Column

Heading 4 Anywhere Next 2 In Column

Heading 5 Anywhere Next 2 In Column

HeadingRunIn Anywhere Next 2 Run-In Head - Default 
Punctuation: .

IndexIX Anywhere Next 2 In Column

IndexTitle Anywhere 2 In Column

IndexTitleTOC Anywhere 1 In Column

InsertCaution Anywhere 2 In Column

InsertNote Anywhere 2 In Column

InsertTip Anywhere 2 In Column

Level1IX Anywhere 1 In Column

Level2IX Anywhere 1 In Column

Level3IX Anywhere 1 In Column

Numbered Anywhere 2 In Column

Numbered1 Anywhere 2 In Column

OneStep Anywhere 2 In Column

SeparatorsIX Anywhere 2 In Column

TableFootnote Anywhere Previous 2 In Column

TableTitle Anywhere Next 2 In Column

Title Anywhere Next 1 In Column

Title cover Anywhere 2 In Column

Paragraph Start Keep With Widow/
Orphan Format
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Numbering tab

Paragraph Auto Format / 
Command Character Format Position

AppendixTitle Default Start of Paragraph

AppendixTitleTOC Default Start of Paragraph

Body Default Start of Paragraph

Body Indent Default Start of Paragraph

Bulleted Yes: l\t (lower case L) BulletSymbol Start of Paragraph

BulletIndentRound Yes: l\t (lower case L) BulletSymbol Start of Paragraph

BulletIndentSquare Yes: q\t BulletSymbol Start of Paragraph

CellBody Default Start of Paragraph

CellHeading Default Start of Paragraph

ChapterNumber Yes: <$chapnum> Default Start of Paragraph

ChapterTitle Default Start of Paragraph

ChapterTitleTOC Default Start of Paragraph

ContentsTitle Default Start of Paragraph

Footer Yes Default Start of Paragraph

Footnote Default Start of Paragraph

GlossaryBullet Yes: l\t (lower case L) BulletSymbol Start of Paragraph

GlossaryDefinition Default Start of Paragraph

GlossaryLetter Default Start of Paragraph

GlossaryTerm Default Start of Paragraph

GlossaryTitle Default Start of Paragraph

GlossaryTitleTOC Default Start of Paragraph

GroupTitlesIX Default Start of Paragraph

Header Yes Default Start of Paragraph

Heading 1 Default Start of Paragraph

Heading 1TOC Default Start of Paragraph

Heading 2 Default Start of Paragraph

Heading 2TOC Default Start of Paragraph
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Heading 3 Default Start of Paragraph

Heading 3TOC Default Start of Paragraph

Heading 4 Default Start of Paragraph

Heading 5 Default Start of Paragraph

HeadingRunIn Default Start of Paragraph

IndexIX Default Start of Paragraph

IndexTitle Default Start of Paragraph

IndexTitleTOC Default Start of Paragraph

InsertCaution Default Start of Paragraph

InsertNote Default Start of Paragraph

InsertTip Default Start of Paragraph

Level1IX Default Start of Paragraph

Level2IX Default Start of Paragraph

Level3IX Default Start of Paragraph

Numbered Yes: \t<n+>.\t StepNumber Start of Paragraph

Numbered1 Yes:  \t<n=1>.\t StepNumber Start of Paragraph

OneStep Yes: u\t OneStepDiamond Start of Paragraph

SeparatorsIX Yes: <n>-<n+> Default Start of Paragraph

TableFootnote Default Start of Paragraph

TableTitle Default Start of Paragraph

Title Default Start of Paragraph

Title cover Default Start of Paragraph

Paragraph Auto Format / 
Command Character Format Position
3 - 12 December 2002



Paragraph Tag Specifications
Advanced tab FrameMaker Template User Guide
Advanced tab

Paragraph Max# 
Adj.

Short 
Word

Short 
Pref

Short 
Suff Hyph Min Max Opt Frame 

Above
Frame 
Below

AppendixTitle 2 5 3 3 90 110 100 Blue Line

AppendixTitleTOC 2 5 2 2 75 125 100

Body 2 5 3 3 90 110 100

Body Indent 2 5 3 3 90 110 100

Bulleted 2 5 3 3 90 110 100

BulletIndentRound 2 5 3 3 90 110 100

BulletIndentSquare 2 5 3 3 90 110 100

CellBody 2 5 3 3 90 110 100

CellHeading 2 5 3 3 90 110 100

ChapterNumber 2 5 3 3 90 110 100

ChapterTitle 2 5 3 3 90 110 100 Blue Line

ChapterTitleTOC 2 5 2 2 75 125 100

ContentsTitle 2 5 3 3 90 110 100 Blue Line

Footer 2 5 3 3 90 110 100

Footnote 2 5 3 3 90 110 100

GlossaryBullet 2 5 3 3 90 110 100

GlossaryDefinition 2 5 3 3 90 110 100

GlossaryLetter 2 5 3 3 90 110 100

GlossaryTerm 2 5 3 3 90 110 100

GlossaryTitle 2 5 3 3 90 110 100 Blue Line

GlossaryTitleTOC 2 5 3 3 90 110 100

GroupTitlesIX 2 5 3 3 90 110 100

Header 2 5 3 3 90 110 100

Heading 1 2 5 3 3 90 110 100

Heading 1TOC 2 5 3 3 90 110 100

Heading 2 2 5 3 3 90 110 100

Heading 2TOC 2 5 3 3 90 110 100

Heading 3 2 5 3 3 90 110 100

Heading 3TOC 2 5 3 3 90 110 100

Heading 4 2 5 3 3 90 110 100
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Heading 4TOC 2 5 3 3 90 110 100

Heading 5 2 5 3 3 90 110 100

HeadingRunIn 2 5 3 3 90 110 100

IndexIX 2 5 3 3 90 110 100

IndexTitle 2 5 3 3 90 110 100 Blue Line

IndexTitleTOC 2 5 3 3 90 110 100

InsertCaution 2 5 3 3 90 110 100 Caution

InsertNote 2 5 3 3 90 110 100 Note

InsertTip 2 5 3 3 90 110 100 Tip

Level1IX 2 5 3 3 90 110 100

Level2IX 2 5 3 3 90 110 100

Level3IX 2 5 3 3 90 110 100

Numbered 2 5 3 3 90 110 100

Numbered1 2 5 3 3 90 110 100

OneStep 2 5 3 3 90 110 100

SeparatorsIX 2 5 2 2 90 110 100

TableFootnote 2 5 3 3 90 110 100

TableTitle 2 5 3 3 90 110 100

Title 2 5 3 3 90 110 100

Title cover 2 5 3 3 90 110 100

Paragraph Max# 
Adj.

Short 
Word

Short 
Pref

Short 
Suff Hyph Min Max Opt Frame 

Above
Frame 
Below
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Table Cell tab

Paragraph Cell Vertical 
Alignment Top Bottom Left Right

AppendixTitle Top 0 0 0 0

AppendixTitleTOC Top 0 0 0 0

Body Top 0 0 0 0

Body Indent Top 0 0 0 0

Bulleted Top 0 0 0 0

BulletIndentRound Top 0 0 0 0

BulletIndentSquare Top 0 0 0 0

CellBody Top 0 0 0 0

CellHeading Middle 2.0 2.0 0 0

ChapterNumber Top 0 0 0 0

ChapterTitle Top 0 0 0 0

ChapterTitleTOC Top 0 0 0 0

ContentsTitle Top 0 0 0 0

Footer Top 0 0 0 0

Footnote Top 0 0 0 0

GlossaryBullet Top 0 0 0 0

GlossaryDefinition Top 0 0 0 0

GlossaryLetter Top 0 0 0 0

GlossaryTerm Top 0 0 0 0

GlossaryTitle Top 0 0 0 0

GlossaryTitleTOC Top 0 0 0 0

GroupTitlesIX Top 0 0 0 0

Header Top 0 0 0 0

Heading 1 Top 0 0 0 0

Heading 1TOC Top 0 0 0 0

Heading 2 Top 0 0 0 0

Heading 2TOC Top 0 0 0 0

Heading 3 Top 0 0 0 0

Heading 3TOC Top 0 0 0 0

Heading 4 Top 0 0 0 0
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Heading 5 Top 0 0 0 0

HeadingRunIn Top 0 0 0 0

IndexIX Top 0 0 0 0

IndexTitle Top 0 0 0 0

IndexTitleTOC Top 0 0 0 0

InsertCaution Top 0 0 0 0

InsertNote Top 0 0 0 0

InsertTip Top 0 0 0

Level1IX Top 0 0 0 0

Level2IX Top 0 0 0 0

Level3IX Top 0 0 0 0

Numbered Top 0 0 0 0

Numbered1 Top 0 0 0 0

OneStep Top 0 0 0 0

SeparatorsIX Top 0 0 0 0

TableFootnote Top 0 0 0 0

TableTitle Top 0 0 0

Title Top 0 0 0 0

Title cover Top 0 0 0 0

Paragraph Cell Vertical 
Alignment Top Bottom Left Right
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 MASTER PAGE SPECIFICATIONS

Overview
Master pages control the layout of pages in a document. A double-sided document has three 
master pages, one for left pages, one for right pages, and one for the first page of the document. 
The chapter and appendix templates have two additional pages for left and right landscape 
pages. 

Each master page has a text frame in the body area, and most have a header text frame at the top 
and a footer text frame at the bottom.

To view a master page, select View, and then select Master Pages. Text frames are surrounded 
by dotted lines. To select a text frame, hold down the CTRL key and click the border of the 
frame.

To view the properties of a text frame, select the frame and then select Format, Custom 
Layout, and then select Customize Text Frame. 

This chapter provides the settings for the text frames used in the multichapter FrameMaker 
templates. 
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Chapter and appendix master pages

Body text frame – first page

The following example provides settings for the body text frame on the first page of the chapter 
and appendix templates. 
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Body text frame – right and left pages

The following example provides settings for the body text frame on the right and left pages of 
the chapter and appendix templates. 
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Body text frame – landscape pages

The following example provides settings for the body text frame on the landscape pages of the 
chapter and appendix templates. 
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Header text frame – left and right pages

The following example provides settings for the header text frame on the left and right pages of 
the chapter and appendix templates.
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Header text frame – landscape pages

The following example provides settings for the header text frame on the landscape pages of the 
chapter and appendix templates.

None of the templates have a header text frame on the first page.
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Footer text frame – first, left, and right pages

The following example provides settings for the footer text frame on the left, right, and first 
pages of the chapter and appendix templates. 
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Footer text frame – landscape pages

The following example provides settings for the footer text frame on the landscape pages of the 
chapter and appendix templates. 
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Front matter master pages

Body text frame – first page

The following example provides settings for the body text frame on the first page of the 
frontmatter.fm template.
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Body text frame – right and left pages

The following example provides settings for the body text frame on the right and left pages of 
the frontmatter.fm template.
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Header text frame – left and right pages

The following example provides settings for the header text frame on the left and right pages of 
the frontmatter.fm template. 
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Footer text frame – left and right pages

The following example provides settings for the footer text frame on the left and right pages of 
the frontmatter.fm template. 

There is no header or footer on the first page of the front matter template.
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Copyright text frame

The copyright text frame is on the body page of the front matter template, not the master page. 
The settings for the copyright text frame are set as follows:
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Glossary master pages
The glossary template has two body text frames on the first page. The upper body text frame is 
for the title. The lower text frame is for the glossary terms and definitions. 

The header and footer text frames in the glossary template are identical to all other templates.

Although the footer is similar to other templates, the page numbering format is different. The 
glossary page numbers are formatted as “GL – #,” where “#” is the actual page number. 

Upper body text frame – first page

The upper body text frame on the first page of the glossary is set as follows: 
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Lower body text frame – first page

The following example provides settings for the lower body text frame on the first page of the 
glossary template. 
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Body text frame – left and right pages

The following example provides settings for the body text frame on the left and right pages of 
the glossary template.
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Index master pages
The index template has two body text frames on the first page. The upper body text frame is for 
the title. The lower text frame is for the index entries. 

The lower body text frame on the first page of the index is divided into two columns. The left 
and right pages of the index only have one body text frame, however it is divided into two 
columns.

The header and footer text frames in the index template are identical to all other templates.

Although the footer is similar to other templates, the page numbering format is different. The 
index page numbers are formatted as “IX – #.” 

Upper body text frame – first page

The upper body text frame on the first page of the index is set as follows: 
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FrameMaker Template User Guide Index master pages
Lower body text frame – first page

The following example provides settings for the lower body text frame on the first page of the 
index template. 

Note there are
two columns
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Body text frame – left and right pages

The following example provides settings for the body text frame on the left and right pages of 
the index template.

Note there are
two columns
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Table of contents master pages
The table of contents (TOC) template has two body text frames on the first page. The upper body 
text frame is for the title. The lower text frame is for the TOC entries. 

The header and footer text frames in the TOC template are identical to all other templates.

Although the footer is similar to other templates, the page numbering format is different.The 
TOC page numbers are lower case roman numerals beginning with page 3 (iii).

Upper body text frame – first page

The upper body text frame on the first page of the TOC template is set as follows: 
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Lower body text frame – first page

The following example provides settings for the lower body text frame on the first page of the 
TOC template. 
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Body text frame – left and right pages

The following example provides settings for the body text frame on the left and right pages of 
the TOC template.
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